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Please note the following.
• Panasonic cannot be held liable for any direct or indirect damages resulting from

the use or malfunction of this projector.
• Panasonic cannot be held liable for damages arising from data corruption or loss

as a result of using this projector.
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Wireless connection function of the projector uses radio waves in the 2.4 GHz band. 
A radio station license is not required, but be sure to read and fully understand the
following items before use.

� Do not use near other wireless equipment.
The following equipment may use radio waves in the same band as the projector.
When the projector is used near these devices, radio wave interference may make
communication impossible, or the communication speed may become slower.
• Microwave ovens, etc.
• Industrial, chemical and medical equipment, etc.
• In-plant radio stations for identifying moving objects such as those used in factory

manufacturing lines, etc.
• Designated low-power radio stations

� If at all possible, avoid the use of cellular phones, TV sets or
radios near the projector.

Cellular phones, TV sets, radios and similar devices use different radio bands from
the projector, so there is no effect on wireless communication or the transmission
and reception of these devices. However, radio waves from the projector may
produce audio or video noise.

� Wireless communication radio waves cannot penetrate steel
reinforcements, metal, concrete, etc.

Communication is possible through walls and floors made from materials such as
wood and glass (except glass containing wire mesh), but not through walls and
floors made from steel reinforcements, metal, concrete, etc.

Notes on Using Wireless Connection
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� Channels that can be used
The channels (frequency range) that can be used differ according to the country or
region. Refer to the table below.

Notes on Using Wireless Connection (cont.)

England, Germany,
France, Spain
Italy, Belgium,
Austria, Sweden,
Norway, Denmark,
Switzerland, Holland,
Finland, Portugal,
Greece, Thailand,
South Korea 

United States

Taiwan

2,412 MHz -
2,472 MHz

2,412 MHz -
2,464 MHzDGT

ETSI 300.328

SIRIM

Country or region

Japan ARIB STD-T66

FCC part 15

1 - 13

1 - 11

Malaysia

IDASingapore

C-TickAustralia, 
New Zealand

Standard Channels used
Frequency band

(Center frequency)
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Examples of Network Function Usage

Computer equipped 
with wireless LAN

Transmission

Installation

Wireless Manager ME 2.0
(DirectX 9.0c Driver)

Projector

Live mode

Computer equipped 
with wireless LAN

PC1 PC2 PC3 PC4

1 2 3 4

5 6 7 8

9 10 11 12

13 14 15 16

Standard style
(4-screen multi live mode)

Projector

1

1 2 3 4

2

3 4

Computer equipped 
with wireless LAN

PC1 PC2 PC16

16-screen index style

Projector

Computer equipped 
with wireless LAN

PC1 PC2 PC3 PC4

4-screen index style

Projector

1 2 3 4

…�

1

1 2 1 2 163 4

�

Software
Installation
(See page 8)

Simple Wireless
Connection
(See page 11)

Using Wireless
Manager ME 2.0
(See page 14)

Projecting a computer image by wireless operation

Transmission to multiple projectors

Projector Projector

Computer equipped 
with wireless LAN

Projector

The projectors illustrated
as examples are 
PT-LB20NTU.
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Examples of Network Function Usage (cont.)

LAN

Access Point (AP) ProjectorComputer equipped 
with wireless LAN

Use in infrastructure mode

Computer equipped 
with wireless LAN

Control 
by WebBrowser 

Projector

Controlling the projector by WebBrowser Simple Wireless
Connection
(See page 11)

Using
WebBrowser
(See page 38)

The projectors illustrated as examples are PT-LB20NTU.
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Software Installation

The computer must meet the following requirements in order to use the supplied
software.

OS: Windows 98SE (Second Edition) /Me (Millennium Edition) /2000
Professional/XP Home Edition/XP Professional

CPU: Pentium III or faster or compatible processor (800 MHz or faster is
recommended when using l ive mode and 1 GHz or faster is
recommended when playing movies.)

RAM: 128 MB or more (256 MB or more for Windows 2000/XP). 
Empty hard disk capacity: 

60 MB or more
Hardware conditions: 

CD-ROM drive (for software installation and viewing the user’s manual)
An 802.11 b/g built-in wireless LAN system or an 802.11 b/g wireless
LAN card must be installed and running properly.
However, some 802.11 b/g wireless LAN may not allow connection to
802.11 g projectors.

Web browser: Internet Explorer 6.0 or newer
Netscape Communicator 7.0 or newer

DirectX: Environment required for running Ver.8.1b or newer

System requirements

Operation is not guaranteed for all computers that
meet the above conditions.

Note:
Note that operation is not guaranteed when used with system environments other
than the above or on homemade computers.
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Software Installation (cont.)

Wireless Manager ME (Mobile Edition) 2.0
Wireless Manager ME 2.0:
This software is used to send screen images from a computer to the projector via a
wireless LAN.

Notes:
• Shut down all software currently active on Windows. Otherwise, installation may

not be possible.
• Administrator authority is required for installation with Windows 2000/XP.

Set the supplied CD-ROM in the CD-ROM drive.
The installer starts up automatically and the following screen appears.1

Note:
If the installer does not start up automatically, double-click [EasyInstall] →
[Easy_Inst.exe] in the CD-ROM.

Note:
If Wireless Manager ME 1.0 has been installed, uninstall it by following the
instructions on the screen.

Click [Wireless Manager ME 2.0].
Follow the instructions on the screen and install the software.2
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Software Installation (cont.)

DirectX 9.0c Driver
To transfer moving picture using the projector, your computer must have DirectX driver
Ver.8.1b or newer. This CD-ROM has the latest version of DirectX. However, it cannot
be installed in a machine which runs Windows 98SE or Windows Me.

Click [DirectX 9.0c Driver] in step
1 on page 9.
The License Agreement for DirectX appears.

1

Place a check in the [I accept the
agreement] checkbox and click
[Next].
The DirectX Runtime component install window
appears.

2

Click [Next].
• The DirectX component install progress bar

appears.
• Do not perform any other operations until

installation is complete.

3

Click [Finish] when the window on
the right appears.4

Notes:
• Once installed, the DirectX 9.0c Runtime cannot be uninstalled.
• In rare cases, installing DirectX 9.0c may prevent your computer from starting up

properly. Before installing, be sure to verify with the customer support office of the
manufacturer that the video card of your computer is compatible with DirectX 9.0c.

• No guarantees are made for the operation of Wireless Manager ME 2.0 with a
version newer than DirectX driver Ver. 9.0c.
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Simple Wireless Connection (Using the Initial Settings)
When making a wireless connection between the projector and the computer using the
default settings, if the projector is in the ON condition, and the computer has built-in
wireless LAN or has a wireless card installed (with the driver installed and running
properly), the necessary settings will be made automatically when Wireless Manager
ME 2.0 is started.
However, note that Wireless Manager ME 2.0 must be installed.
For details on changing the initial settings and using the changed settings, refer to
pages 29 to 36.

Notes:
• Operation is not guaranteed for all wireless cards and built-in wireless LAN

adapters.
• Refer to the following URL for the types of wireless cards that can be used.

http://panasonic.co.jp/pavc/global/projector/
• Other network adapters may not be usable under simple connections.
• Connections to other networks connected through the wireless card are broken

during simple connections.
• Administrator authority is required for installation of simple connections in

Windows 2000/XP. (Refer to page 53 for the procedure if you do not have the
authority of the administrator and to page 48 for the restrictions applying in such a
case.)

Projector operations

Turn on the projector.

Note:
When using a computer which is not equipped with an built-in wireless LAN, install
the wireless card driver beforehand. For details on how to install the driver, refer to
the instructions accompanying the wireless card.
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Computer operations

Turn on the computer.1
Select [Start] → [Programs] → [Panasonic Wireless
Display] → [Wireless Manager mobile edition 2.0].
Wireless Manager ME 2.0 starts up, and the connection select window shown
below appears.

2

Select the connection and click [OK].
The launcher shown below appears and the connection with the projector is
established.

3

Simple Wireless Connection (Using the Initial Settings) (cont.)

Notes:
• The initial network number for both the projector and the computer is “1”.

These numbers must match for the connection.
Also, WEP is enabled when network number is anything but “1”, so when security
is a concern, use a different number than “1”.
Image and audio data are encrypted using AES in all networks, so essential data
are protected.

• Depending on the computer and wireless card used, automatic setup may not be
possible. If this is the case, the [Network] setting on the screen in step 2 above will
be switched to [USER] automatically. For details of the connection procedure, first
close Wireless Manager ME 2.0, and then refer to page 32.

• When anti-virus software and utilities for network cards are installed, these may
prevent connection of the projector. (See pages 51 to 53)

For multiple transmissions,
refer to page 23.
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Canceling the connection with the projector

Click [ ] on the launcher.

The following window appears.

1

Click [Yes].
The computer returns to the original network settings when the connection is
ended.
However, note that some time may be needed to return to the original network
settings.

2

Simple Wireless Connection (Using the Initial Settings) (cont.)
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Using Wireless Manager ME 2.0

Description of the connection select window

When the network number to be
connected differs, select the
network number to be connected.
The network settings change
according to this selection.
This network number is stored in
the computer, so connection is
performed with the current
number the next time Wireless
Manager ME 2.0 is started up.

This indicates the number of people connected to this
projector.

This indicates the status of this projector.

This appears when password entry is needed for connection. 
(See page 27)

Projector name (See page 30)

When there are two or more projectors with the same name, each
projector is automatically assigned its own ID for identification purposes.

The equipment to be connected can be designated when [Network] 
is set to [USER].

Click this to display the projector name at the upper left of the projection screen for
the projector in question.

When only one projector is connected, select [Single] and the
projector from the list of destination.
When multiple projectors are connected, select [Multi-] and
select multiple projectors.

When the [Make an automatic connection] checkbox in [Automatic connection setting]
has been checked in Options (see page 26) and a connection with the projector
registered as a destination for automatic connection is possible, connection with the
projector will be performed automatically, and the connection select window will not be
displayed.

Startup

Select [Start] → [Programs] → [Panasonic Wireless Display]
→ [Wireless Manager mobile edition 2.0].
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Description of the launcher and menu

(Green, lighted): Transmission possible

(Blue, blinking): Own computer currently transmitting
(in the live mode or moving picture transmission mode)

(Yellow, lighted): Other user currently transmitting

(Red, lighted): Communication impossible

(Black, lighted): When the projector has not been selected

Status indication

When connected to one projector

(Green, lighted): All transmission possible

(Blue, blinking): Currently transmitting

(Yellow, blinking): Communication impossible for more than one unit

(Red, lighted): All communication impossible

When connected to multiple projectors

• The launcher always appears on the computer screen, and can be used to perform
various operations.
Two types of launchers are available in the Launcher Display Mode, the simple launcher
and the full launcher. Ordinarily, the full launcher is displayed. The Launcher Display
Mode can be toggled by clicking on the button on the right side of the launcher window.
Two window sizes are allowed, the standard and an expanded version. This is
controlled in [Launcher size setting] in Options (see page 26).

• Right-click [ ] on the task tray to display the menu when the menu has been
placed on the task tray by the launcher.

Using Wireless Manager ME 2.0 (cont.)

Cancel connection

Place in task tray

Simple launcher Full launcher

Pointer mode on/off

See next page

Toggling Launcher
Display Mode

(Continued on next page)

Notes:
• With Windows 2000 or Windows XP, the launcher appears only on the computer

screen and is not projected by the projector.
• With Windows 98SE or Windows Me, you can place the launcher on the task tray

and use it as a menu from the task tray when you do not wish to display the
launcher on the projector’s projection screen.
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Using Wireless Manager ME 2.0 (cont.)

Full launcher

Menu

Live Mode: Displays the computer screen over the entire projection screen.
(See page 17)

Multi Live Mode: Offers a choice of three styles: the standard style (for displaying
the images on one of the four windows into which the screen
has been divided), the 4-screen index style (for displaying 4
indexed images), and the 16-screen index style (for displaying
the images on one of the 16 windows into which the screen has
been divided).
In 16-screen index style mode, [ ] changes to [ ]. (See pages 18 to 21)

One Shot: Transmits a snapshot of the current computer screen to the
projector one time. (See page 21)

Moving picture transmission:
Displays the movie select window. (See page 22)

However, this menu item does not function with Windows 98SE
or Windows Me. When transferring to or closing moving picture
transmission, the computer screen blanks for a moment, but
this is not an indication of any malfunction.

Shutter: Blanks the screen for a moment. (This menu item functions only
in the live mode.)

Remote control: Starts up WebBrowser. (See pages 40 to 44)

Change Access Port: Displays the connection select window. (See page 14)

OPTION: Displays the option setting window. (See pages 24 to 26)

About: Displays the Wireless Manager ME 2.0 version information.

Display Menu Bar: Displays the launcher. 
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Using Wireless Manager ME 2.0 (cont.)

Check the status indication on the launcher to make
sure that transmission is possible (check that the
green lamp is lighted).

1

Click [ ] on the launcher.

The current computer screen is transmitted to the selected projector. In the live
mode the projector is occupied by a single computer, so operations from other
computers are not possible.

2

� Quitting live mode

Click [ ] on the launcher.

Live mode

Notes:
• For presentations in live mode, the [ ] buttons on the remote control will

function in the same way as the computer’s Page Up and Page Down keys. This
means that if you run a computer application that supports the [ ]buttons, the
presentation screen can be changed using the remote control.

• Movie play is slowed if [High Definition] is selected in the Options.
• Some portions of images are not projected under some applications (MS Office

Assistant, IME Bar, and others).

Note:
Whether to keep the last image in the projector or clear it after quitting live mode
can be set as an option. (See page 25)

Live modeProjector side
Computer side Multi

Live mode

Standard style

4-screen index style

16-screen index style

One shot
mode

Moving picture
transmission

� Screen styles that allow the projection modes to be used

= Yes   = No

THE TRUSTED SOURCE FOR PROJECTOR LAMPS AND ACCESSORIES



18

Using Wireless Manager ME 2.0 (cont.)

Multi live mode
Multi live mode allows simultaneous projection of the contents of the monitors of 4
computers (Standard style, 4-screen index style) and of 16 computers (16-screen
index style) onto a single screen.

Switching from one style to another
Either press the [INDEX WINDOW] button on the remote control or select [INDEX
WINDOW] on the projector's main menu (See page 28) and press the [ENTER] button.

4-screen index style

16-screen index style

Notes:
• The default setting is the standard style.
• When the projector starts up, it resumes in the current style the last time the

projector was turned off.
• When the style setting is switched, the connection to the computer is broken, so

this must be re-established.
• When transferring to the live mode, first select the standard style, and then click

[ ] on the computer.

Standard style
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Using Wireless Manager ME 2.0 (cont.)

Check the status indication on the launcher to make
sure that transmission is possible (check that the
green lamp is lighted).

1

Click [ ] on the launcher.2
Select and click the projection position.
The computer image is transmitted to the selected quarter of the projection screen.3

Switching to a different position
Select and click a different projection position in step 3
above.

Quitting multi live mode
Select and click the checked position in step 3 above.

Note:
In the 4-screen multi live mode, the computer screens from all the
computers connected to the projector can be transmitted to the
projector. (If an image from another computer has been sent to
the image position where an image is already displayed, the
existing image is replaced by the new image.)

� Standard style (4-screen multi live mode)

� 4-screen index style
Check the status indication on the launcher to make
sure that transmission is possible (check that the
green lamp is lighted).

1

Click [ ] on the launcher.2
Select and click the projection position.
The computer image is transmitted to the area of
corresponding window.

3
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Quitting multi live mode

Select and click the checked position in step 3 on the previous page.

Note:
In the 4-screen index style mode, the green status display lamp remains lighted.
Other computers can send images only to the windows which are not being used.

Using Wireless Manager ME 2.0 (cont.)

Note:
While an enlarged image is displayed, the [ ] buttons on the remote control will
function in the same way as the computer’s Page Up and Page Down keys. This
means that if you run a computer application that supports the[ ]buttons, the
presentation screen can be changed using the remote control.
Now use the [ ] button to set the window of the application that you want to run
to the active status. (If you operate the launcher, you will set the launcher to the
active status: as a result, you will need to set the window of the required application
to the active status again.)

Enlarged display
• Use the [ ] buttons on the remote control to

move the focus (yellow box) to the image to be
enlarged, and press the [ENTER] button. The
image is enlarged and displayed at the top of the
projection screen.

• The image display will fill the entire screen if the
[ENTER] button is pressed again.

• To return to the 4-screen index style, press the
[ENTER] button again.
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One shot mode
In this mode, a snapshot of the current computer screen is transmitted to the projector.

Check the status indication on the launcher to make
sure that transmission is possible (check that the
green lamp is lighted).

1

Click [ ] on the launcher.2

Using Wireless Manager ME 2.0 (cont.)

Quitting multi live mode

Click [ ] on the launcher again.

Check the status indication on the launcher to make
sure that transmission is possible (check that the
green lamp is lighted).

1
Click [ ] on the launcher.

The computer images are automatically sent to the empty windows on the 16-screen display.

2

� 16-screen index style

Enlarged display
• Use the [ ] buttons on the remote control to move the focus (yellow box) to

the image to be enlarged and press [ENTER] to expand that image to fill the display.
• Press [ENTER] again to return to the 16-screen style.

Toggle between
these with the

[ENTER] button.

Note:
While an enlarged image is displayed, the [ ] buttons on the remote control will function
in the same way as the computer’s Page Up and Page Down keys. This means that if you
run a computer application that supports the[ ]buttons, the presentation screen can be
changed using the remote control.
Now use the [ ] button to set the window of the application that you want to run to the
active status. (If you operate the launcher, you will set the launcher to the active status: as a
result, you will need to set the window of the required application to the active status again.)

Note:
Select the standard style before operating. (See page 18)
However, this mode cannot be used while any other computer connected over the
wireless network to the projector in use is transmitting a snapshot.
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Using Wireless Manager ME 2.0 (cont.)

Moving picture transmission 
� Displaying the moving picture transmission window

Notes:
• Select the standard style before operating. (See page 18)

However, this mode cannot be used while any other computer connected over the
wireless network to the projector in use is transmitting a snapshot. 

• The allowed formats are those accepted by Windows Media Player, including asf,
wmv, avi and mpeg.

• Some frames may be lost or the audio may be disrupted in some computing environments.
• Moving picture transmission mode does not function with Windows 98SE or Windows Me.

Check the status indication on the launcher to make
sure that transmission is possible (check that the
green lamp is lighted).

1

Click [ ] on the launcher.

The computer screen will blank out for a moment, and the window shown
below will then appear.

2

Play
The movie will be displayed by the projector.
It will not be displayed on the computer screen.

Stop

Pause

Continuous play/ON-OFF
Use this to set continuous play to ON or OFF.

Exit moving picture transmission mode
The computer screen will blank out for a
moment, and the moving picture
transmission mode is exited.

Volume
This enables the level of the volume
supplied to the projector to be adjusted.

Seek Bar
This enables jumping to the desired
place during movie play.

� Moving picture transmission window
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Using Wireless Manager ME 2.0 (cont.)

Notes:
• Select the standard style before operating. (See page 18)

However, this mode cannot be used while any other computer connected over the
wireless network to the projector in use is transmitting a snapshot. 

• The greater the number of projectors, the slower the transmission.
• Up to 8 projectors can be connected.
• Multiple source projection mode operations can be performed only in the live

mode and one-shot mode. However, the sound cannot be output in these modes.

Multiple Source Projection Mode
Transmits to multiple selected projectors.

To do this from the launcher:

Click[ ]. The connection select window shown above now appears.

While holding down the Ctrl key, select the desired
projectors, and click [OK].2

Change [Single] to [Multi-].1

Click [ ] on the launcher.

The projectors selected in Step 2 will begin displaying.

4

Check the status indication on the launcher to make
sure that transmission is possible (check that the
green lamp is lighted).

3
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Notes:
Selecting [High Definition] imposes the following limits on operation.
• In moving picture transmission, operations are performed in the normal mode.
• When a movie is playing in the live mode, it may not be displayed smoothly.

Click [ ] on the

launcher.
The window shown to the right
appears.

Pointer mode
You can change the shape of the pointer appearing on the projection screen in live
mode to one that can be used for presentation purposes [ ].

Click [ ] on the launcher.

� Quitting pointer mode

Click [ ] on the launcher.

Options
You can make various settings related to Wireless Manager ME 2.0.

Select [Normal] or [High Definition].

� Picture quality selection
Select the quality of the image transmitted from the computer to the projector.

� Version information
The version information of Wireless Manager ME 2.0 is displayed when [ ] on the
options window is clicked.

Using Wireless Manager ME 2.0 (cont.)
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� Live mode settings
You can set the computer operation in live mode and multi live mode.

[Remove image when shutting down Live Mode]:
Check this box to clear the projection screen from the projector when live mode
ends. Normally the image when live mode ends remains projected.

[Disable Screen Saver]:
This disables the computer screen saver function while Wireless Manager ME 2.0
is operating. Check this box to disable screen saver operation during live mode.

[Display sender’s name in Multi Live Mode]:
The characters (max. 8) which have been entered are displayed at the upper right
of the transmitted screen. 
In the 4-screen and 16-screen index style modes, they are also displayed at the
bottom of each image. 
(Alphanumerics are not displayed when the check mark has been removed.)

[Produce audio along with video at live mode]:
You can set this when you want to output audio data from a computer while in live mode.
However, the sound in the moving picture transmission mode does not reflect this setting but
it is determined by the volume level which was adjusted on the moving picture transmission
window. (See page 22.) Sound cannot be output in the multi live mode.

� Shortcut key settings
You can set shortcut key combinations that let you control the Wireless Manager ME
2.0 functions by computer keyboard operations.

[Live Mode]:
Shifts to full screen display.

[Multi Live Mode]:
Shifts to multi screen display.

[One Shot]:
Transmits the entire computer 
screen one time.

[Use “Pause” key to stop/continue Live Mode]:
Stops live mode and multi live mode.

[Use “PrintScreen” key to execute One Shot]:
Transmits the entire computer screen one time.

Note:
In live mode and multi live mode, the shortcut key switches the mode without
stopping live mode.

Click [Key setting].

Using Wireless Manager ME 2.0 (cont.)
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Using Wireless Manager ME 2.0 (cont.)

� Launcher size and automatic setting of destinations
You can set the launcher size and can perform automatic settings for a newly
connected projector.

Click [Other].

Launcher size setting
Click the [Large button] or the [Small button].

Automatic connection setting
• If the [Make an automatic connection] box is checked and a projector is registered as

a destination for automatic connection when Wireless Manager ME 2.0 is started,
connection is performed automatically.

• When [Setting] is clicked, projector(s) can be selected for automatic connections.
• Up to 5 projectors may be displayed in the order of most recent connection history.

However, projectors used in multiple source projection mode are ignored for this
ordering.
When it is desired to remove a projector from the display list, select it and press the
[DELETE] button.

THE TRUSTED SOURCE FOR PROJECTOR LAMPS AND ACCESSORIES



27

Adding and deleting connections

Click [ADD] and enter the IP address
(including its periods) of the connection
to be added, and then click [REGISTER].
The newly registered connection is added to the
connection list in the window shown in step 1.

2

Click [Designate] at the
connection select window.
The window shown to the right appears.

1

Using Wireless Manager ME 2.0 (cont.)

When [Network] is set to [USER] at the connection select window, connections can be
added and deleted by the following operations.

� Adding a connection

When a projector with the [ ] mark is selected, the window

shown to the right appears. Enter the password and click [OK].
(see page 31) 

Notes:
• Click [CANCEL] at the password entry window to return to launcher (See page 12).
• When an incorrect password is entered, an error message appears. Click [OK] to

return to the password entry window and enter the correct password again.

Operations when password entry is required for connection

� Deleting a connection
Select the connection to be deleted at the window shown in step 1 and click [DELETE].
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Displaying the Network Menu
Perform the procedure below to display the network menu required when changing the
initial settings.

Press the [MENU] button on the projector.
The main menu appears.

1

Select [NETWORK] with the [ ] buttons, then press
the [ENTER] button.
The network menu appears.

2

N E T W O R K
1

LB20NT
OFF

ON

NETWORK
NAME CHANGE 
INPUT PASSWD
AMEND PASSWD
WEB CONTROL
STATUS
DEFAULT
   SELECT RETRNENTER

MENU
KEYSTONE
PICTURE
POSITION
INDEX WINDOW
SHUTTER
VOLUME
LANGUAGE
OPTION
SECURITY
NETWORK
SELECT ENTER EXIT

Concerning on-screen items which are not displayed:
Depending on the signals which are input to the projector, it may not be possible to
adjust some of the items and use some of the functions.
In the case of an item that cannot be adjusted or a function that cannot be used, the
corresponding on-screen item will not be displayed, and you will not be able to
execute it even when you press the [ENTER] button.
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Other Applications (Changing the Initial Settings)
When making a wireless connection between a computer and the projector with
settings other than the default settings, make the following settings.

Changing the network number
� Projector operations

Select [NETWORK] at the network menu and press the
[ENTER] button.1
Select the number to be connected
with the [ ] buttons and press
the [ENTER] button.

2 N E T W O R K

USER

ADJ RETRNENTER

� Computer operations
Perform steps 1 to 2 on page 12, then perform the following operation.

Select the network group from the network number
list.1

Notes:
• Network number [1] is connected in WEP-disabled Mode, and Networks [2-4] are

connected in WEP-enabled mode. AES encryption is used for image and audio
data for all networks to protect essential data.

• [USER] is used when the computer’s network settings are to be performed
manually for connection with the projector. (See pages 33 to 35)
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Other Applications (Changing the Initial Settings) (cont.)

Changing the projector name
You can change the projector name on the network.

Select [NAME CHANGE] at the
network menu and press the
[ENTER] button.

1

Enter the projector name using
the [ ] buttons.2

After entering the projector name,
select [OK] and press the [ENTER]
button.
To cancel the change, select [Cancel] and press
the [ENTER] button.

3

1
LB20NT

ON

ON

NETWORK
NAME CHANGE 
INPUT PASSWD
AMEND PASSWD
WEB CONTROL 
STATUS
DEFAULT
   SELECT

N E T W O R K

RETRNENTER

LB20NT
NAME CHANGE

BS OK Cancel

ABCDEFGHIJKLM
NOPQRSTUVWXYZ
a b c d e f g h i j k l m
n o p q r s t u v w x y z
0123456789
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Wireless connection with password

� Projector operations

This setting is used to limit the users that can connect to the projector.

Select [INPUT PASSWD] on the
network menu.1

Select [ON] with the [ ] buttons.2

Select [AMEND PASSWD] at the
network menu and press the
[ENTER] button.

3

Enter the password using the 
[ ] buttons.4

After entering the password,
select [OK] and press the [ENTER]
button.
To cancel the change, select [Cancel] and press
the [ENTER] button.

5

1
LB20NT

OFF

ON

NETWORK
NAME CHANGE 
INPUT PASSWD
AMEND PASSWD
WEB CONTROL
STATUS
DEFAULT
   SELECT

N E T W O R K

RETRNENTER

1
LB20NT

ON

ON

NETWORK
NAME CHANGE 
INPUT PASSWD
AMEND PASSWD
WEB CONTROL
STATUS
DEFAULT
   SELECT

N E T W O R K

RETRNENTER

AMEND PASSWD

BS OK Cancel

ABCDEFGHIJKLM
NOPQRSTUVWXYZ
a b c d e f g h i j k l m
n o p q r s t u v w x y z
0123456789

� Computer operations
Refer to pages 14 and 27.

Other Applications (Changing the Initial Settings) (cont.)
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� Computer operations (Wireless settings (See page 35))

Open the Windows TCP/IP Setting window, and set the TCP/IP.
(See page 33 or 34)
Refer to the Windows manual for a detailed description.
For the subnet mask, register the same value as the default projector network
[USER] setting.
For the IP address, enter the same value up to the “255” part of the default
subnet mask setting for projector network [USER], and then enter a different
value for the remainder.

2

Start up the wireless card utility.
When using Windows XP, open [Control Panel] →
[Network Connections].
Make the same SSID,
communication mode and WEP
settings as the default projector
network [USER] settings.

Default projector network [USER] settings
SSID : Panasonic Projector
Communication mode : 802.11 AdHoc
WEP : Off

1

Start up Wireless Manager ME 2.0, select [USER] from the
network number list, and set the network. (See page 29)

Wait until the projector’s name appears on the connection list, select the name
displayed, and proceed with the connections.

3

User connections (not using simple connections)

1
LB20NT

OFF

ON

NETWORK
NAME CHANGE 
INPUT PASSWD
AMEND PASSWD
WEB CONTROL
STATUS
DEFAULT
   SELECT

N E T W O R K

RETRNENTER

N E T W O R K

USER

ADJ RETRNENTER

Select [NETWORK] on the network
menu, and press the [ENTER]
button.

1

Select [USER] with the [ ]
buttons, and press the [ENTER]
button.

2

Other Applications (Changing the Initial Settings) (cont.)

� Projector operations (Network number settings)

If the projector and computer could not be connected by following the steps on page
12, connect them by performing the steps below.

Setting item
Default projector network Example of 

[USER] setting computer setting
Subnet mask 255. 255. 255. 0 255. 255. 255. 0
IP address 192. 168. 10. 100 192. 168. 10. 101

Setting Example

THE TRUSTED SOURCE FOR PROJECTOR LAMPS AND ACCESSORIES



33

Other Applications (Changing the Initial Settings) (cont.)

TCP/IP settings
Windows 2000/XP:
The screens show the example for Windows XP.

(1) Right-click [My Network Places] to open the Properties
window.

(2) Right-click the Wireless LAN icon being used to open
the Properties window.

(3) Select Internet Protocol (TCP/IP) and click
[Properties].

(4) Enter the same segment IP address as the IP address
set by the projector.

(5) Enter the same value as the subnet mask set by the
projector, set the gateway (only in infrastructure
mode), and then click [OK] to return to the previous
window.

(6) Click [OK].
The new settings can be used without rebooting.
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Other Applications (Changing the Initial Settings) (cont.)

Windows 98SE/Me:
The screens show the example for Windows Me.

(1) Right-click [My Network Places] to open the Properties
window.

(2) Right-click the Wireless LAN icon being used to open
the Properties window.

(3) Enter the same segment IP address as the IP address
set by the projector.

(4) Enter the same value as the subnet mask set by the
projector.

(5) Set the gateway (only in infrastructure mode) and click
[OK] to return to the previous window.

(6) Click [OK].

(7) Click [Yes].
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Other Applications (Changing the Initial Settings) (cont.)

Windows XP (SP2):
The dedicated utility software is not necessary. Refer to the Windows XP manual for a
detailed description.

(1) Turn on the projector.

(2) Select [Start] → [Connect To] → [Show all connections], and display the [Network
connections] window.

(3) Right-click [Wireless network connection], and left-click [View Available Wireless
Network].

(4) Select the projector’s SSID at [Choose a wireless network] (“Panasonic Projector”
is the default setting for network [USER]), and then click [Connect To].

Notes:
• When encryption (WEP setting) is set by the projector, enter the WEP key

(character input) information to [Network Key] before clicking [Connect To]. 
(default setting: No WEP)

• To check the detailed network settings, click the [Wireless network settings] icon
at the network connection window.

Windows 98SE/Me/2000:
Start the utility software for your wireless LAN card to make the settings. See the
User’s Manual for your LAN card for details.

Note:
Do not use the utility software during simple connection, as this may cause a
problem in connection with the projector. (For instance, the “Projector search in
progress” message may appear on the connection select window list.)

Wireless settings
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Select [STATUS] in the network menu
(see page 28) and press [ENTER].
Your current settings appear.

Verifying settings

Other Applications (Changing the Initial Settings) (cont.)

1
LB20NT

OFF

ON

NETWORK
NAME CHANGE 
INPUT PASSWD
AMEND PASSWD
WEB CONTROL
STATUS
DEFAULT
   SELECT

N E T W O R K

RETRNENTER
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Returning to the Initial Settings
You can return the changed settings to the initial conditions.

Select [DEFAULT] at the network menu (See page 28) and
press the [ENTER] button.1

Select [OK] with the [ ] buttons and press the
[ENTER] button.2

1
LB20NT

ON

ON

NETWORK
NAME CHANGE 
INPUT PASSWD
AMEND PASSWD
WEB CONTROL
STATUS
DEFAULT
   SELECT

N E T W O R K

RETRNENTER

D E F A U L T  S E T T N I G
OK CANCEL

Projector operations

Start the Wireless Manager ME 2.0 and set the network
number to [1] (see page 29).

Computer operations

Note:
You will be prompted to enter the password if ON has been selected as the [INPUT
PASSWD] setting on the security menu.
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Computer settings

Notes:
• When the projector settings have been changed using a WebBrowser, the

projector will not appear on the connection list until the projector network is
switched to [USER].

• After the projector network has been switched to [USER], manually release the
proxy settings of the WebBrowser used.

Using WebBrowser

Projector settings

WEB CONTROL
ON: This enables control on the WebBrowser.
OFF: This disables control on the WebBrowser.

Select [WEB CONTROL] on the network menu (See page 28).1

Select [ON] or [OFF] with the [ ] buttons.2

Note:
The WebBrowser password is not set at the factory, and should be set on the
WebBrowser. In addition, if you forget the password, select [DEFAULT] at the
network menu and initialize the network settings. (See page 37) 

Connect the projector and computer before taking the steps below. 
(See page 12 or page 32)

1
LB20NT

OFF

ON

NETWORK
NAME CHANGE 
INPUT PASSWD
AMEND PASSWD
WEB CONTROL
STATUS
DEFAULT
   SELECT

N E T W O R K

RETRNENTER

Click [ ] on the launcher (See page 15).1
Change the projector settings by WebBrowser.
Make the SSID, communication mode, IP address, subnet mask and WEP
settings, and then quit WebBrowser.

2

THE TRUSTED SOURCE FOR PROJECTOR LAMPS AND ACCESSORIES



39

Using WebBrowser (cont.)

Select [Security] and set the security level to [Default Level],
or select [Custom Level] and check the [Enable] checkbox
under [Active scripting].

Right-click the [Internet Explorer]
icon.
Open the Properties window.

1

Open [Connections] → [LAN
Settings]. If [Use automatic
configuration script] has been
checked, remove the check, and
click [OK].
The setting window closes.

2

Note:
Under [Advanced] you must set the IP address of the projector to be connected for
not using the proxy server as an exception. However, this setting will be
automatically established if network numbers 1 to 4 are used by Internet Explorer.

Note:
When using Netscape, select [Edit] → [Preferences] → [Advanced] and enable
JavaScript.

� When a proxy server is already being used

� Enabling JavaScript
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Using WebBrowser (cont.)

Starting up WebBrowser
Click [ ] on the launcher (see page 15) or start up the WebBrowser, and enter

the IP address set by the projector.
(The example below describes the case when using Microsoft Internet Explorer.)

WebBrowser starts up.

� Top window

Notes:
• If you forget the password, set a new password on the projector side. (The former

password is protected by security, and cannot be viewed even by the projector.)
• The top window may not appear depending on the WebBrowser. In this case start

up WebBrowser again, or press the [Ctrl] + [R] keys.
• Connection cannot be made while the WebBrowser is set to dial-up network.

Cancel the dial-up network setting.
• It may take some moments for WebBrowser to start up.

Set to not use a proxy server. (When using a
proxy server, refer to page 39.)

Enter the password when a password is set.

Select English or Japanese.
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Using WebBrowser (cont.)

Projector control window
Click [Projector Control] in the menu.
You can make various projector settings.

� Basic control window

� Option control window

Notes:
• Connection with the projector may not be possible immediately after the power is

turned on. In this case wait a bit and then make the connection again.
• When [WEB CONTROL] is not set to [ON] in the projector network settings, the

basic controls and option controls do not operate.

Note:
When the projector does not operate as controlled, check that the [WEB
CONTROL] item in the projector’s option menu is set to [ON].

THE TRUSTED SOURCE FOR PROJECTOR LAMPS AND ACCESSORIES



42

Note:
The monitor information is refreshed at
fixed intervals, but the current exact
information can be checked by clicking
[View] → [Refresh].

Using WebBrowser (cont.)

Enter the old password and new password,
and click [OK].

Monitor information window

Password changing window
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Using WebBrowser (cont.)

� Setting the infrastructure mode

You can make the setting for infrastructure mode (connection through the access point
(AP) ); however, confirm to your system Administrator before changing any settings.

Network setting window

Click [Network setting] on the
menu.1

2 Click [Next].
The Settings window appears.

IP ADDRESS
DHCP ON : Check this if the AP supports DHCP.
DHCP OFF : Check this if the AP does not support DHCP, and make the

following settings:
IP ADDRESS : IP address designated for projector
SUBNETMASK : SubNetMask used by the AP
GATEWAY : IP address of GateWay registered in the AP

MODE
Check “INFRASTRUCTURE”
(If this is performed directly at the computer rather than via the AP, check
“802.11 AD-HOC.”)

SSID
Enter SSID registered in the AP.
(If this is connected in AdHoc mode, set the SSID of the computer.)

(Continued on next page)
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WEP
OFF : Check this when the WEP is not registered in the AP.
ON : Check this when the WEP is registered in the AP, and make the

following settings.
Authentication

OPEN : Check this when the AP authentication is Open System.
SHARED : Check this when the AP authentication is Shared Key.

(If this is performed in AdHoc mode, select OPEN.
However, some computers may require connection by
SHARED authentication.)

KEYLENGTH
Set the length of the WEP KEY.
64 Bit : Alphanumeric – 5 characters; Hexadecimal – 13 characters
128 Bit : Alphanumeric – 13 characters; Hexadecimal – 26

characters
DEFAULT KEY ID

Set 1 – 4 numerals for the default WEP KEY.
INPUT FORMAT

CHARACTER : Check this when the input is alphanumeric.
HEXADECIMAL: Check this when the input is hexadecimal code.

KEY 1 – 4
Set these to match the WEP KEY registered in the AP.

Using WebBrowser (cont.)

3 Click [Next].
The above settings will be registered in the user settings of the projector.

� Making the above settings effective
Select [NETWORK] in the network menu of the projector (see page 28), and use the
[ ] buttons to select [USER] and press the [ENTER] button.

Notes:
• The projector supports only 64 bit and 128 bit WEP codes.
• WPA and WPA2 are not supported. However, image and audio data are all

encrypted using AES, so essential data are protected.
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Software Uninstall
Wireless Manager ME 2.0

From the desktop, select [Start] → [Programs] → [Panasonic
Wireless Display] → [Uninstall Wireless Manager mobile
edition 2.0].
Follow the instructions appearing on the screen and uninstall the software.
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Terminology
802.11 AD-HOC (Peer to Peer) mode
This is the mode in which computers communicate with each other directly, rather than
via access points.

Access point
These are stations for relaying electromagnetic signals between computers in a
wireless LAN. When a computer is connected to an access point, it can communicate
through the network connected to the access point.

DHCP
Abbreviation for Dynamic Host Configuration Protocol. This function automatically
assigns IP addresses to the connected equipment. If a device with the DHCP server
function is present within a LAN, it automatically assigns IP addresses to the
connected equipment. 

Gateway
This is a relay point for connecting different networks.
This refers to the hardware and software used when connecting a network with a
network that uses a different protocol, etc. It adjusts the protocol and other differences
between networks to allow connection with other networks.

Infrastructure mode
This is the mode in which communications are performed via the access point.

IP address
Internet Protocol (IP) is a protocol for distributing data, and the address corresponding
to the data distribution destination is called the IP address. The same IP address
cannot be used within the same LAN.

LAN
Abbreviation for Local Area Network. This is a network with a relatively narrow range
such as inside a company. There are wired LAN and wireless LAN.

Open System
This is an authentication of wireless signals employing a public key cryptosystem.
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Shared Key
This is a secret key encryptosystem for wireless signals in which authentication is
performed with a key pre-set in the WEP.
Other terms for this method, in which the same key is used for both encryption and
decryption, are “shared key encryptosystem” and “common key encryptosystem”.

SSID
Abbreviation for Service Set ID. The SSID identification code must be set to distinguish
equipment included in a wireless LAN that uses access points from equipment not
included in that LAN.
This may appear as the “ESSID” or the “network name” for wireless LAN cards made
by some manufacturers.

Subnet mask
This limits the range of the IP addresses assigned to computers in order to divide the
network into a number of sections during TCP/IP connection. The value used to divide
the network at this time is called the subnet mask.

TCP/IP
Abbreviation for Transmission Control Protocol/Internet Protocol. This is the standard
internet protocol.
This protocol is a set of rules and agreements governing data communications
between computers.

WEP
Abbreviation for Wired Equivalent Privacy. This is a method for encrypting
communication data. The encryption key is created and notified only to the
communicating user, so the communication data cannot be decrypted by a third party.

Terminology (cont.)
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Frequently Asked Questions
Check the following points once more before requesting repair.

The transfer rate is slow.

• The transfer rate may be slower in some operating environments (depending on
such factors as the location, radio signal conditions or distance).

• Avoid placing metal objects or other conductors near the wireless LAN antenna
of a personal computer, otherwise the transfer rate may be slower.

• When WEP is set the image data is converted, so transfer takes time.

Image display is slow in live mode.

• Is the computer CPU speed slow?
Live mode depends largely upon the computer CPU performance.

• When using Windows 2000/XP, the speed may drop significantly if the user
does not have administrator authority.

• The speed may be slower when any other applications are running concurrently. 

The Wireless Manager ME 2.0 color display is strange and characters are difficult to read.

• Right-click an empty location on the desktop and select [Properties]. Then, open
the [Settings] tab of the [Display Properties] window and set [Color quality] to
[Medium (16 bit)] or higher.

Screen saver is not displayed properly in live mode.

• Some screen savers may not be displayed properly in the live mode.
Disable screen saver function using [Live Mode Settings] in Options of Wireless
Manager ME 2.0. (See pages 24, 25.)

Movies are slow in the live mode.

• Did you start up Microsoft PowerPoint or Windows Media Player before starting
up Wireless Manager ME 2.0?
If so, start up the application only after you have started up Wireless Manager
ME 2.0.
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No wireless connection can be made between my projector and my computer.

• One of the following windows may appear when a wireless connection cannot
be made. In a case like this, refer to pages 50 to 53.

When a setting error for the wireless LAN card has been detected

When the Network Bridge setting has been detected

When Windows Firewall has been detected

When another firewall has been detected

When the user does not have the administrator authority

When a change in the settings made by the utility has been detected

Frequently Asked Questions (cont.)
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Frequently Asked Questions (cont.)

No wireless connection can be made between my projector and my computer. (cont.)

• Is Wireless Manager mobile edition 2.0 running?
Wireless Manager mobile edition 2.0 must be started in the computer in order to
enable wireless transmissions of images to the projector.

• Is the wireless LAN card effective?
Even if your computer has integral LAN, the wireless LAN may still be turned
OFF. If so, turn it ON and re-start Wireless Manager mobile edition 2.0. See the
User’s Manual of your computer to learn how to turn the wireless LAN power
ON/OFF.

• Is your wireless LAN card properly recognized on the network?
Sometimes, cards are not correctly recognized by the network. Check Windows
“Device Manager” to make sure your card has been recognized.
If the Network Adapter is indicated with “?” in [Device Manager], LAN card
installation is not complete. See the User’s Manual of your card and re-install
the card driver.

To display “Device Manager”
Right-click [My Computer] on your desktop (Windows XP – in your [Start] menu)
and choose [Properties] in the menu. This will bring up the [System Properties]
dialog box.
<Windows 2000/XP>

Click the [Hardware] tab and then [Device Manager].
<Windows 98SE/Me>

Click the [Device Manager] tab.

• Some wireless cards may allow simple connections to function if drivers are
updated (consult the manufacturer of your driver about updates).
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Frequently Asked Questions (cont.)

No wireless connection can be made between my projector and my computer. (cont.)

• Is Network Bridge enabled?
Some PCs with Windows XP may have Network Bridge (a built-in function of
Windows XP) enabled; this will prevent a wireless connection. The settings in
Network Bridge must be changed in order to make a wireless connection. If you
do not expect ever to use Network Bridge and see no need for it, delete it from
your system.

To verify whether your system has Network Bridge
Choose [Connect to] on the [Start] menu and click [Show all connections]. Verify
that [Network Bridge] is displayed in the [Network Connections] window.

How to change settings in Network Bridge
1. Select [Connect to] on the [Start] menu and click [Show all connections].
2. Right-click [Network Bridge] and click [Properties].
3. Remove the check mark from the [Wireless Network Connection] box in the

[Network Bridge Properties] dialog box (if the box is not checked, proceed to
step 4.)

4. Click [Properties] in [Internet Protocol (TCP/IP)] in the [Network Bridge
Properties] dialog box.

5. Click the [Alternate Configuration] tab in the [Internet protocol (TCP/IP)
properties] dialog box.

6. Check the [User configured] box and set the [IP address] and [subnet mask]
as follows:

IP address : 10. 10. 10. 101
Subnet mask : 255. 255. 0. 0

(If the above IP address is already in use in the LAN environment,
change it as appropriate in Class A.)

7. Click [OK] → [Close].
8. Close the [Network Connections] dialog box.

How to delete the network bridge
1. Select [Connect to] on the [Start] menu and click [Show all connections].
2. Right-click [Network Bridge] and click [Delete].
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Frequently Asked Questions (cont.)

No wireless connection can be made between my projector and my computer. (cont.)

• Has your firewall in Windows XP SP1 been disabled?
The firewall in Windows XP must be disabled in order to connect to a wireless
network.

How to disable the firewall in Windows XP
1. Click [Start] → [Control Panel] → [Network Connections].
2. Right-click [Wireless Network Connection] and click [Properties] in the pull-

down menu.
3. Click the [Advanced] tab and set the [Internet Connection Firewall] checkbox

to OFF.

• Is Wireless Manager mobile edition 2.0 registered with the Windows XP SP2
Security Center firewall?
Register Wireless Manager mobile edition 2.0 in the Exceptions to Application
List of the firewall.

How to register
1. Click [Start] → [Control Panel].
2. Click [Security Center] when [Control Panel] window opens.
3. Click [Windows Firewall] under [Manage security settings for:] when the

[Windows Security Center] window opens.
4. Click the [Exceptions] tab and then [Add Program…] when the [Windows

Firewall] window opens.
5. Click [Wireless Manager mobile edition 2.0] (WM.exe) to allow connection

with external devices under [Programs] when the [Add a Program] window
opens.
If Wireless Manager mobile edition 2.0 does not appear on the list of
programs, click [Browse...] and select [Wireless Manager mobile edition 2.0]
(WM.exe).

6. Click the [Change scope…] button at the lower left of the window.
When the [Change Scope] window opens, select the desired network as
described below.

7. Select any computer (including computers on the internet).
8. Select the scope and click [OK].
9. Click [OK] in the [Add a Program] window.

10. Click [OK] in the [Windows Firewall] window.
With this, the Wireless Manager mobile edition 2.0 firewall will be deleted.
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No wireless connection can be made between my projector and my computer. (cont.)

• Are any firewall-containing applications installed?
If any applications which contain firewalls are installed, the installation may hang
up at the [Projector search in progress] display (some firewalls function even
when not started).
If this occurs, firewall settings must be changed in order to allow connection to
the wireless network. See the User’s Manuals for all applications containing
firewalls to perform these settings.

• Have you logged in as the Administrator?
If you have logged onto a computer running Windows 2000 or Windows XP as a
guest, who does not have the privileges of an Administrator, you can not
perform a simple connection (Network No. 1 – 4). If you must perform wireless
connection while logged in as a guest, designate [USER] as the network
number.
See page 29 or 32 for instructions in how to set [USER] as the network number.
Alternatively, log in as the Administrator and set the Hardware acceleration to
[None].

How to set the Hardware acceleration to [None]
(may not be applicable in all computers)
1. Click [Settings] tab in the [Display Properties] dialog box.
2. Click [Advanced] and select the [Troubleshoot] tab in the resulting dialog box.

The Hardware acceleration settings menu will be displayed.
3. Move the lever all the way to the left end ([None]) and click [Apply].

Note that when you have set the Hardware acceleration to [None], image
transfer functions are degraded.

• I can connect with the projector using the simple connection, but then the
connection is lost shortly afterward.
The wireless LAN utility used by the computer may have changed the wireless
settings. Close the utility, and then make the connection again using the simple
connection.

Frequently Asked Questions (cont.)
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Frequently Asked Questions (cont.)

The launcher is displayed in the projection screen.

• The launcher is projected in the projection screen of the projector in Windows
98SE/Me. If you do not want this shown, click [ ] in the launcher. This stores
the launcher in the task tray.

There is a time lag between operations at the computer and results in the projected image.

• Wireless Manager mobile edition 2.0 reads the screen, compresses the data
and transmits it to the projector. In the projector, the received data are extracted
and then projected. Some delays occur in this system, due to the processing
time and factors in the wireless environment. Different computers may also
produce varying lag times.

PowerPoint animations are not displayed smoothly.

• There are some variations in playability of animations depending on computer
capabilities; some animation effects are not completely reproduced. If you wish
to run PowerPoint animations, we recommend creating them in advance and
trying them out on your projector.

Supported operating systems

• This projector is supported on Windows 98SE/Me/2000 Professional/XP Home
Edition/XP Professional.
It is not compatible with any other systems.
Moving picture transmission does not function with Windows 98SE or Windows
Me.

Changing the display style

• The projector is designed to provide three display styles: standard style, 4-
screen index style, and 16-screen index style.
Press the [INDEX WINDOW] button on the remote control to toggle between
styles, or select [INDEX WINDOW] on the projector’s main menu (see page 28)
and press the [ENTER] button.
When the style is changed, the connection between the computer and the
projector is canceled. 
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Frequently Asked Questions (cont.)

Some contents in movies are not displayed.

Movies are not displayed smoothly.

I can’t hear the computer sound from the projector in the live mode.

• Check whether the check mark has been entered for [Produce audio along with
video at live mode] from [Live Mode Settings] under the [Transmission] tab
selected from Wireless Manager options.

• If there is still no sound even after the action in the above item has been taken,
check the settings of the recording device by following the steps below.
1. Select [Start] → [Programs] → [Accessories] → [Entertainment] and then [Volume Control].

(The same window can be opened by right-clicking the sound icon at the
bottom right of the screen and selecting [Open Volume Control].)

2. On the menu bar, select [Options] → [Properties].
3. Check whether the selected mixer device is the correct one.
4. Select [Recording] under [Adjust volume for], and enter check marks for all

the controls displayed.
5. Click [OK] to display the audio recording adjustment window.
6. Select [Stereo Mixer]. 2

7. Upon completion of the above settings, start playing an audio file, for
example, check that sound is heard from the computer, go live, and check
whether the sound is output from the projector.

2 The control selected here differs depending on the operating system and
environment used. Try selecting another control if [Stereo Mixer] is not
available or the sound is not output even after selecting [Stereo Mixer].

• The playability of movies depends on the capability of the computer you are
using and on the wireless environment. We recommend using the powerful
computer available when projecting a movie. Wireless reception is disrupted
when other wireless equipment is operating nearby; it should be turned off when
using the projector.

• In the live mode, operation will slow down also when the Windows Media Player
window is not active. Select this window before playing a movie. However,
operation may be delayed with some materials even when the Windows Media
Player window is set to active.

• Basically, files which can be viewed on Windows Media Player can be viewed
with this projector. However, contents protected by DRM 1 cannot be projected
nor can such DVDs be played.

1 DRM (Digital Rights Management): Technology for protecting the copyrights
of digital data 
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Frequently Asked Questions (cont.)

Making a wireless connection while using the internet

The remote control window does not appear.

• If you have a wireless LAN environment which allows an internet connection,
placing the projector on that network will allow you to use the internet and the
wireless connection at the same time. 

• If you use a simple connection with two wireless LAN cards, since which card to
be used for the projector will not be clear, you must make the connection
between the computer and the projector through the user settings (manually).

• If you have a wired internet connection (Ethernet), this projector allows wireless
use with simultaneous wired connection to the internet.

<When a simple connection is used>
• When any WebBrowser except Internet Explorer is used, the proxy settings of

the WebBrowser must be manually released.

<When a user connection is used>
• Manually release the proxy settings of the WebBrowser used.

The connection has been lost in the multi live mode.

• If a computer with a certain version of the Centrino technology (wireless LAN) is
connected to the unit, the multi live mode may be released. If this is the case,
re-establish the connection from the launcher of Wireless Manager ME 2.0. (See
pages 19 to 21.)

The connection cannot be established with IEEE802.11 g.

• Connection is sometimes established under the IEEE802.11 b standard even
when an IEEE802.11 g wireless LAN card or a computer with built-in wireless
LAN that supports the IEEE802.11 g standard is used. This is, therefore, not an
indication of trouble.
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Trademarks

Notes:
• Unauthorized use or reproduction of part or all of this product software and

manuals is strictly prohibited.
• Panasonic cannot be held liable for any effects resulting from the use of this

product software and manuals.
• Panasonic reserves the right to revise this product software specifications and

manual contents without notice.

• Windows is a trademark or registered trademark of U.S. Microsoft Corporation in the
U.S. and other countries.

• Other company names, product names or other names noted in this manual are
trademarks or registered trademarks of the respective companies. Note that ® and
TM marks are not indicated in the text of this manual.

C   2005 Matsushita Electric Industrial Co., Ltd. All Rights Reserved.

M0205-1045

Professional/Industrial Video

Panasonic Broadcast & Television Systems Company
Division of Panasonic Corporation of North America

3330 Cahuenga Blvd West Los Angeles, CA 90068 (323) 436-3500

Technical Support:
(800) 222 -0741
E-Mail: pbtscservice@panasonic.com

Panasonic Canada Inc.
5770 Ambler Drive, Mississauga, Ontario L4W 2T3 (905) 624-5010
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Sponsored by DDMM

This user manual is provided as a free service by FixYourDLP.com.  FixYourDLP is in no way responsible
for the content of this manual, nor do we guarantee its accuracy.  FixYourDLP does not make any claim
of copyright and all copyrights remain the property of their respective owners.

About FixYourDLP.com
FixYourDLP.com (http://www.�xyourdlp.com) is the World’s #1 resource for media product news, 
reviews, do-it-yourself guides, and manuals.

Informational Blog:  http://www.�xyourdlp.com
Video Guides: http://www.�xyourdlp.com/guides
User Forums: http://www.�xyourdlp.com/forum

FixYourDLP’s Fight Against Counterfeit Lamps:
http://www.�xyourdlp.com/counterfeits

RecycleYourLamp.org – Free lamp recycling services for used lamps:
http://www.recycleyourlamp.org

Lamp Research  - The trusted 3rd party lamp research company: 
http://www.lampresearch.com

Discount-Merchant.com – The worlds largest lamp distributor:
http://www.discount-merchant.com
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